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Anomauyin. Y cmammi npedcmasiena akmyanbHa npodiIema moyHoOCmi 004UCIEHHA 06 eMY 3eMIAHUX
Pobim, wo HAOGE MONCTUGICING IMEHULUMU 6APMICINb Peaii3ayil nPoeKmy 6epMUKATbHO0 NIAHYBAHH
perbey mepumopii npi npoeeoeHHi iHjceHepHO-MeTiopamuetx 3axooie. Ilpoananizoeani HaeuwibHi Ma
HAYKOGI nyOiikayii, 0e po32naodiomsCs KAAcuyHi Memoou po3paxyHky 06 €mie 3eMIaHUX MAc 3d 6i0oMuMu
2eo0esudnumu popmynamu. Ha ocroesi ananimuunozo 02110y nyoaikayiit chopmyiibo6ano 3ae0amnHs — o0ep-
Hcamu HatlbibUL O0CMOGIPHI PO3PAXYHKOGT 3HAUEHHSA 06 €MY 3eMIAHUX POBiM 3a OONOMO2010 A6MOMamil-
306aHO20 MemoOa euUsHaveHHs. /(1A eupiuieHHs nOCMasieHol 3a0a4i peanizoeaHuil NPUKIA0 0duUCTeHH
00 €My 3eMIAHUX Mac O 6ePMUKATILHO20 NAAHYEAHHA 13 3ACMOCOGYEUAHHAM NPOSPAMHO20 KOMNJIEKCY
Golden Sofiware Surfer8, akuil ¢ eanyseeum cmanoapmom noGyooeul 2pagiiunux 300paxcetv (QyHKyiil
080X 3MIHHUX M OOHICIO 3 Kpauyux npozpam O1s nodyooe mpusuMipHUx noeepxoHs md ix 00pooxu.
V Oaniit nyonikayii pos2iaHymo nocriooeHicms po3paxyHKy 00 €My IPYHIMOGUX MAc Ol 6ePMUKATLHO2O
PAAHYBAHHA PeNbeqy 20PU3OHMANLHOT MA HAXUACHOT QINAHOK | 8USHAYEHA GIOHOCHA NOXUOKA 00YUCTEHb.
Jlocmogipricms ompumanux sHauens 00 'emy oyiHeHa UIAXOM NOPIBHAHHA pe3yTbmamie pisHuMit po3pa-
xyHkoeumu memooamu (« Ipaneyiiy, «Cimnconay, «Cimncona 3/8» ma «Keaopamie») ma no éanancy
«euUIMKU-Hacunyy. 3a pesyibmamamiu PO3PAXYHKI6 6CMAHOGICHO, WO GIOHOCHA NOXUOKA 00YUCTEHO20
06 ‘eMy 2opuzoHmanbHol i noxunol OLAHOK 3Haxooumves 6 mexcax 6io 0,03-0,06%, a bananc semianux
pobim 1,65-4,6%, wo He nepeeuugye peaiamenmosarux cmanoapmamu 5,0%. Ilepeeaeu 3acmocyearns
npoepamu Surfer 8 o6IPYHMOGYIOMbCA 3MEHUIEHHAM 00ca2y ma mpusaiocmi pobim npu CKIadaHHi
nPOEKMy GEPMUKATLHO20 NAGHYGAHHA MA NEPEHECeHHT 1020 8 HAMYPY, d MAKOIC EKOHOMIYHICIIO pedi-
3ayil'y 36 43Ky 3 MEHUL010 GIOHOCHOI0 MA OONYCMUMOI0 NOXUOKOIO PO3PAXYHKIG | GUMIDIOBAHD.

Kuiouosi crnosa: eepmuxaivhe nianyeawus, 00 €M 3emiiHux pobim, cimka keaopamie, yupposa
MOO€b ROGEPXHI.

IMocranoBka mnpobaemu. [lpu npoexTy- mpHUBEACHHS NMPHUPOAHOTO Peabedy A0 CTaHy, 1O

BAHHI CKJIQJOBHX CIEMCHTIB MEIIOPATHBHHX
CHCTEM BHMKOPHCTOBVIOTH Tomorpadiunl KapTu
1 raan macmradis 1:10000-1:5000 3 BucoTO0O
nepetuny peasedy 0.5-1.0 M. Tomorpadiuxoro
OCHOBOK) TSl CKTAJAHHS MPOCKTIB BEPTHKAIb-
HOTO IUIAHYBAHHS CIy’KaTh IUIAHK MacmTady
1:500-1:2000 3 Bucotoro mepetuny peabedy
0,25-0.5 m, moOyzoBaHi 3a pe3ynbTaTaMu HiBE-
TIOBAHHS MOBEpPXHI mo kBagparax 20x20 m [1].
Penped) MicueBOCTI Ma€E BUHSITKOBE 3HAUCHHS 15l
3POLIVBATPHUX 1 OCYIIYBAJIBHHX METIOPALIi.
JetanpHe BuBYECHHS 1 BigoOpaxceHHs penbedy
HA MJIaHl JO3BOBIE YHHUKATH MOXHOOK y MPOEK-
TYBAaHHI Ta PO3PaXyHKaX IH)KCHCPHUX MEPEXK,
BHU3HAUUTH ONTHMAIbHI  TCXHIKO-CKOHOMIYHI
mapaMeTpu Ta pekumu ix podortu. Xapakrep
penpedy 1 yXHUT 3pOImyBaHOi TEPUTOPII € OTHIEO
3 TOJIOBHHUX YMOB A7t BUOOPY CMOCOOY MOTHBY
Ta BEPTHUKAIBHOTO IUIAHYBAHHS OIS, TOOTO

3abe3meuye HAMOIIBII CIPUSTINBI YMOBH ISt
3araqpHOTO IIIAHY OCYIICHHS a00 3POLICHHS.
Pasom 3 mpM, BEpTHKAIBHE TUIAHYBAHHS METIO-
PaTHBHUX ALISHOK € HEBIJ €MHOK CKJI4JI0BOK
3a0e3MeUeHHS CTATOTO SKOIOTO-METI0PATHBHOTO
pexumy (PYHKLIOHYBAHHSI TEPUTOPIl MUISIXOM
30CPEIKCHHSI TPYHTOBOTO MOKPHBY Ta 3aXHCTY
Horo Bia BOAHOI eposti [2; 3].

OcHOoBHa BHUMOTa I PO3POOKH TPOCKTY
BCPTUKAIBHOTO ITUIAHYBAHHS — LIE MIHIMAJIbHHH
o0’em 3emmsamnx  poOit.  [lmamysamms, sk
MPaBHI0, BHUKOHYIOTH B EIMHOMY KOMILICKCI
3 OVAIBHULTBOM CTIOPY/ METIOPATUBHOI CHCTEMHU
13 IOTpUMaHHAM OATAHCY IPYHTOBHX Mac, TOOTO
KOJM TPYHT NEPEPO3MOALTSETECS HA TCPHUTOPII
AUTIHKA ©O€3 HOro 3aBE3€HHS 4YH BHUBC3CHHSL.
[Mpn naseproMy KOHTpOM B TPOLECI BHUPOO-
HUILTBA 3EMSIHHUX POOIT BIAXUICHHS BIIMITOK
MOBEPXHI (YOPHHUX) BIJ MPOCKTHHX (UCPBOHMX)

© I'B. I'antiu, A.B. 3ycka, 2019

LAND RECLAMATION AND WATER MANAGEMENT Ne 2 = 2019



I'IJIPOTEXHIKA

251

JOTIYCKAKOTBCSI B MEKax =3 M. BiaxuiaeHHs
HACHITY POAIOYOrO INApy IPYHTY AOMYCKAETHCS
B mekax +10% Big mpoextOi. BiaxumcHHs
BIAMITOK TUIAHYBAHHS BIJ MPOCKTHUX JOMYCKa-
€ThCS B MEXKaX £5 CM 3a YMOBH, IO Ll BIIXH-
JACHHS HE CTBOPIOIOTH 3BOPOTHHUX YXHIIB, IO
VCKIQIHIOIOTh BUKOHAHHS TOMHBIB [4].

Hns pospaxvHKy 00 €MiB 3eMISIHHX POOIT
ICHY€ ACKLTbKA PI3HUX METOAIB 1 hopmyn odunc-
neHust. JIOLIIBHICTE METOAY OOIPYHTOBYETHCS
B KO)KHOMY KOHKPETHOMY BHINAJKy 3 Vpaxy-
BAHHSIM peabedy MICHEBOCTI, PO3MIPIB MO,
koH(pirypamii Ta IHMHUX O0COOIMBOCTEH Triapo-
METIOPATHBHOI CHCTEMH, CrOCOOIB Ta 3aco0iB
BUPOOHULITBA POOIT 1 HEOOXIAHOI PO3PAXYHKOBOI
TOYHOCTI 00 €MiB.

AKTYaJIbHICTB AOCTIAMKEHHSL. 321394 BU3HA-
YCHHSI TPYAOMICTKOCTI 3EMISIHUX POOIT (SKHH
00’eM 1pyHTY mOTPiOHO po3pobutu abo HacH-
HIaTH) € JOCHTb AKTYATBHOIO 47151 (paxiBLIB PI3HUX
raay3ed — Mapkimeiaepis, TLAPOTEXHIKIB, Oyai-
BCBHHUKIB QBTO- Ta 3AMI3HHYHHUX JAOPIT TOIIO.
JlOCTOBIpHICTh BU3HAYCHHS 00 €MIB HACHIYy Ta
BHIMKH IPYHTOBHX MAaC HAJAE MOJKIHUBICTh 3MCH-
IIWTH BAPTICTh BUKOHAHHS MPOCKTY BEPTHKAIIb-
HOTO TUTAHYBAHHS.

Meta JOC/IAKEHHS. OGrpyHTyBaHHS
TOYHOCTI 1 TOPIBHSHHS PO3PAXyHKIB 00 €MiB
3eMIISIHEX POOIT 47151 BEPTHKATBHOTO TUIAHYBAHHS
TOPH3OHTATBHOI TA HAXU/ICHOT 3¢ MEIbHUX JLISTHOK
13 3aCTOCYBAHHSM KIACHYHHMX MATCMATHIHHX
METOAIB T MPOrPAMHOTO KOMILICKCY Surfers.

Metoau gocaigzenns. Y 6ararbox mrepenax
HAyKOBO-TCXHIYHOI JTITEPATYPH AOCHTH IIHPOKO
NPEACTABICHI METOAM PO3PAXYHKIB 00 €MiB
seMIstHEX podiT (Mac) v Burmsal Gopmyn. [pu
PO3paxyHKY 00 €MIB 3eMIISIHUX POOIT A71si BEPTH-
KaJIbHOTO TIJIAHYBAHHS PO3MISIAI0ThCS B OCHOB-
HOMY METOJH MPOCKTHHUX TOPH30HTAJICH, MMPOCK-
THUX BIAMITOK HIBEIIOBAHHSIM TOBEPXHI 34
KBaJparamMy, OPOCKTHHX mpodime 1 rpadiuni
metoau [5]. [lig wac BHKOPHCTAHHS METOAY
NPOCKTHUX TOPH30HTANCH 00 €MH 3eMIISIHHX
pobIT PO3PaxoOBYyIOTh 3a CITKOK KBAAPATIB.
Cropony xBagparis BubuparoTts 5, 10 ado 20 M,
3a71CKHO Bl MacmuTaly IUIaHy Ta HEOOX1AHOI
TOYHOCTI PO3PAXYHKY 00 €MIB.

I'padiunl METOAM BEPTHKATBHOTO TILIAHY-
BAHHSI TPYHTVIOTbCSI HQ HAHCCCHHI UYEPBOHHX
(TPOEKTHHX) TOPU30HTAICH Ha IIJIAH 3POLIYBAHOI
(ocywmyBanoi) aiasHkU. s 1poro miaH memio-
POBAHOI TCPUTOPIi 3 TOPU3OHTATSIMH PO3MIUYIOTh
HA HU3KY KBAAPATIB, SIKI TOTIM PO3ALISIOTh Al1aro-
HASIMH Ha TPSIMOKYTHI TPHKYTHHKH. CTOpOHA
KBaApara 3ajJC)KHO BIA peabedy NPUIMAETHCS
y 10-50 M gms mepeciunoro 1 g0 100 M — ams
CIIOKIHHOTO penbedy.
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Po3B’s3aHHsT 3a71a4l BEPTHUKATBHOTO IUIAHY-
BaHHS 33 JOMOMOIOK) CKIaJaHHA CHCTEMHU
PIBHSIHb OCHOBHHX IapaMEeTPIB HA OCHOBI Mare-
MaTHYHOI CTATUCTUKH 34 PE3YIbTaTAMHU EKCIIEPH-
MEHTATBHOTO MOJCTIOBAHHS PILICHD HA MAHIaH-
YHKAX PIZHOTO (DYHKIIOHATBHOTO MPH3HAYCHHS
MPEACTABICHO B [6].

Ha cywsacHoMy eTami pO3BHTKY KOMIT KOTEpH-
3ami A7 MPOEKTYBaHHS pPebed)y BHKOPHCTO-
BYIOTb MCTOIHM HAHMCHIIMX KBAIPATIB 1 KBaapa-
TUYHOTO mporpamyBaHHs. Y myOmxami [7]
3aMPOMOHOBAHO METOAMKY AHATITUIHOTO MPOCK-
TYBaHHSI TIOBCPXHI OyaIBEIPHUX MaHJAHUHUKIB 13
JOTpUMaHHsIM OanaHey semastHux mMac. Otpumani
QHAJITUYHI  3QJEKHOCTI HA OCHOBI METOAIB
HAHMCHIIHX KBAAPATIB 1 KBAAPATUIHOTO MPOrpa-
myBaHHi. ONHCAHO TNPHKIAL BEPTHKATBHOTO
MPOCKTYBAHHs OyAIBEIPHOTO MAHTAHUHKA.

06 emu 3eMasHUX POOIT A7 MPOEKTY BEPTH-
KaIBHOTO IUIAHYBAHHS HA BEAMKHX TUIOIIAX
OOUYHCTIOITBCS 32 TPUTPaHHUMH ab0 YOTHUPH-
rpaHHAME npu3Mami [7].

[Nopsia 3 KTaCHYHUME METOAAMH PO3PAXYHKY
00’ emiB 3eMISTHUX Mac (KOTIOBAHIB. TPAHIICH,
TCONMOTNIYHUX TIOKIAAlB 1 T.II.) Ha CbhOTOAHI
IIHPOKO  3ACTOCOBYIOTBCS — ABTOMATH30BAHI
METOAH BH3HAUCHHSI 00 €My 3 BHKOPHCTAHHSIM
crangaptaux nporpam Excel, Gredo, AutoCAD,
AreGlIS Ta 1HmNX.

PesyabraTn Ta ix ofrosopennsi. Y poGoTi
pO3MIIHYTO  O0uMCIeHHS 00 €My IPYHTOBHX
Mac A8 BEPTHKAIBHOTO IIAHYBAHHS peabedy
3 BHKOPHCTAHHSIM TeOlH(POPMALIHHOI CHCTEMH
Surfers8, sixa 3apa3 4ac € raly3eBUM CTAHJAPTOM
noOyaosu rpadiunnux 300pakeHb QyHKUIH ABOX
3MIHHHX. BIAMIHHOI0 TEpEeBaror) MpPOrpamMu €
3aKIQACHI B HEl QITOPUTMHU 1HTEPHOJSIIL, SIKI
JO3BOMSIIOTE 3 BHCOKOK) SIKICTIO CTBOPIOBATH
nudpoBl MOAET TOBEPXHI 32 HEPIBHOMIPHO
posnomiicHuMH B mipoctopi  ganumu. Kpim
OCHOBHMX (VHKUIA B Tporpami peanizoBaHo
Halblp J0JATKOBUX MOKIUBOCTEH MEPETBOPCHHS
MIOBCPXOHb 1 PI3HUX ONEpauii 3 HUMH, 30KpeMa
oOuHcicHHS 00 €My MK JBOMa TOBEpX-
HAMH, 100yA0Ba MPOpint0, OOUNUCICHHS IO
NOBEPXHI Ta 1HII QYHKLII.

udposa mozenb TMOBEPXHI TPAAMLIHHO
NPEJACTABISIETBCS Y BUMISAL 3HAYECHb Y BYy3Jax
NPSIMOKYTHOT PErVIsIPHOi CITKH, JHUCKPETHICThH
SIKOI BUBHAYAETBHCS 3AJICIKHO BiJ KOHKPETHOI
sagaqi. Jlns 30cpiraHHs TakuX 3Ha4YCHb Surfer
BUKOpHCTOBYE BiacHi daitmu Tuny Grd (aBiiiko-
Boro abo TekcToBoro opmary), siki BKE JABHO
CTalNM CTaHAAPTOM VISl MAKETIB MATEMaruyHOIo
MojenroBanHs 8. 9].

1. Cmeopenns Ho6020 (paiiny 3 oanumu
XYZ. TlobGyaoBa Ovib-sIKOro  300paKEHHS
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NOBEpXHI B Surfer MOYMHAETHCS 3 MIATOTOBKH
Gdaiiny, MmO MICTHTh JaHI 3a KOOPAMHATAMH.
XYZ — ue uucnora iHopmamis, ska Ckaaia-
€THCSI 3 HC MEHLI HIJK TPbOX CTOBIILIB, MIEPII 1BA
3 sikux € aprymeHTa X 1 Y, a tpeTiit (abo 1xmi) —
sk Qyakuisa(i) Z uux aprymentis, He momyce-
KAaEThCS POOHTH MPONYCKIB TMPH BBCACHHI
TAKUX JAHUX, TOOTO A7 KOXKHOI Mapy 3HAYCHD
X 1 Y o60B’s13k0BO MOBHHHI OyTH NPHCYT-
HIMHU 3HAUCHHS BCIX QyHKUiH Z. 15 KOKHOTO
CTOBMIS MOXKHA 3aJaBaTH KOPOTKI TEKCTOBI
KOMEHTap1. 3HaYeHHS TOnorpadivHOi MOBEPXHI
B TOYKax 3agamTbes B Tabmumi. [Ipu umpomy
MO’KHa BHKOPHCTOBYBATH BOYIOBAHY B MAaKET
Tabmumioo  ab0 CKOPHUCTATHCS EACKTPOHHOO
tabmuuero Excel 3 maxety Microsoft Office [8].
B CICKTPOHHY TaOIUII0 3aHOCITHCS BHUXIIHI
gaHl. Y mepii ABa CTOBMLI 3PYUHILIC 3aHCCTH
koopauraru X 1 Y (came tam Surfer mykae ix
3a 3aMOBUYBaHHIM). Y TPETIH CTOBITYHK 3aHO-
CATh 3HAYCHHS a0COTIOTHHX BIAMITOK BEPIINUH
KBapaTiB (B HIH 3a 3aMOBUYYBAHHIM MPOrpamMa
mykae 3HaucHHS Z (puc. la).

CrBopennst HOBOro (hailly BHKOHYETBCS
xomanaoto File / New abo kuonxoro [ Ha maneni
iHCcTpyMeHTIB. [Ticas nporo 3°sBUTHCS AlaToroBe
BikHO New (Cmeopumu). Sxmo BuOpaTH MmyHKT
Worksheet (Po6ouuii nucm) 1 KIAHYTH KHOTIKOO
OK., Tozi 3 IBUTHCSI HOBE TIOPOYKHE BIKHO POOO-
4oro nucra. BiamosiaHo tabmuunmii (aiin 3amu-
cvioTh B miakaranor Dat (puc. 1, 6).

2. Biokpumms icuytovoco ¢haiiay 3 oanumu
XYZ. Hnus toro mo6 BIAKPUTH TOTOBHE (haiin
(*.dat) 3 narmmu XYZ B okpeMe BIKHO poO0oI0ro
HCTA HEOOXI1IHO!

1. Bukonatu xomanay [ile/Open abo Buko-
PHCTOBYBaTH KHOMKY 2 Ha MaHel IHCTPYMEHTIB
Main. 3’gBuThCS CTaHZAPTHE JlaTOTOBE BIKHO
Open (Biakpurn).

2.V cnucky (aiinie Bubparu im s aiiny.
dat 1 xnauayTé kHONIKY Open. Im™ st mporo (aiimy
3"SIBUTBCS B 3ar0JIOBKY BIKHA POOOYOro aucTa.

3. HeoOxiano 3ayBakutu, mo B ctoBmii A
3HAXOMITECS 3HAUCHHs KoopauHar X (Kasting,
CXIZHE TIOJIOJKCHHSI), B CTOBIII B — 3HAYCHHS
xoopauHar Y (Northing, miBHIYHE MOIOKESHHS),
B croBnui (' — 3naucHus Z (Elevation, Bucorta).
Texcr 3aron0BKIB CTOBIIIB HE € 000B SI3KOBUM,
ane gonomarac iaeHTH(IKYBATH THI JAHHX
B cToBrmuukax. Jlo Toro i, 1 iHpopMmariis BHKO-
PHCTOBVETBCS B PI3HUX JIaJOTOBHX BIKHAX, A€
noTPIOHO BHOMpATH CTOBMLI POOOUIOrO THCTA.

®daiin 3 TabnuuHWUMH gaHWUMH - 30epira-
eTbcst B (ailml 3 3a4aHAM 1M SIM, HATPHUKIAT
«DakmBiomBepuKeao»  abo  «Daxmuyni
giomimrku eepumn». Posmmpenns daiitty 3a
3aMOBUYBaHHIM BHOMpawTh Fxcel SpreadSheet
(* xIs). File > Save > ®axtBiamBepmKsaz xls.
Hassa ¢aiiny 3amaerscst Ha cBiii poscya. s
30epesKeHHsT pe3yabTariB 0akaHO CTBOPHUTH HA
TOKATbHOMY AMCKY OKPEMHH KaTajor 1 BCepe-
JUHI HBOTO CTBOPUTH miakaramoru: Dat — ams
30epexennst (aitnis 3 gaaumu, Sef — s 30epe-
xkeHHs (aitny HanawrtyBaue Surfer, Grid — nns
30eperkeHHs ciTkoBux (aitnis, SRF — qms 30epe-
seHHs1 Plot BikoH, Bln — pyis 30epesxenns (aiiis
mek, Clr — nist 30epeskeHHSE 3ATHBOK KapT [9].

3. Cmeopenns inmepnoiboeanoi pezy-
asproi cimku e Surfer. Jlns cTBOpeHHS iHTEP-
MOJBOBAHOI perysipHOi ciTku B Surfer (ocHOBa
A1 BCIX MOJAMbIIMX [l B I mporpami)
moTpiOHO MaTH  3a3Jajeriap  MATOTOBICHI
JaHl y Burasgl Tpeox 3HaueHs X, YV, Z, ge X
1 ¥ — xoopauHaTH TOUKH. Z — 3HAYCHHS BUCOTH
B TOUYIL, MPEACTABICHI B OJHOMY 3 HH)KUCBKA-
3aHux (popmartis (puc. 1).

4. Bueedenns na expan kapmu 8uxioHUX
moyok (Post Map). Jlna Bizyamiszauii y BikHI
Plot] posramypaHHsS BCPIIHH MHPOCKTY CITKH
KBAJpaTiB HA KapTi HEOOX1AHO BHOpaTH BIAMO-
BigHe BikHO Plot: menro > Window > Plot]l. Komu
NporpaMa CTBOPKOE HOBE BIKHO P/of, BOHA MPUB-
JTACHIOE LIbOMY BIKHY HACTYTHHH 32 CBOEI) YEPrOK0
HOMEp. Y Hamomy BHMAAKy Oyae ACKIIbKA BIKOH

Surfer - [®atBigmBe puKeaa, ] ‘Save i3 2%
fill Fle Edt Format Data Window Help - —
S 2 H ~| = &) 5 -
DBHQ|X%E|"’““ Narxa: I@ 0BaA Nanka _J & ef B3
& Koopa. PabBlam Hax.nnow .
TOHRAQAALL THN QKOODA‘.PaGEAMHaX,nm.ZZ
QKOODA-O.. Hax,nnow,
72 ' ' MpoerBianBepwisaap
A B c DakTBiamBepwkeaa
1 150 100 505 [T
2 150 110 503
3 150 120 502 < il
1 150 130 50,2 a nf3)
5 150 140 5035 Ura warna: [P axrBiamBepukea, Coxparsis I
b 150 150 506
/ 140 100 298] Tun aiina  [Golden Software Data (-dat) ~] M
a) 0)

Puc. 1. Tlpukian poGoyoro inTepeeiicy Ta BUXIHHX JaHHX
JUIsi CTBOPEHHSI IHTEPIIOILOBAHOI PEry/ISIPHOI CiTKH y mporpami Surfer
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Plot, 1 mocnizoBHicTh aiit Oyae taka: Window >
Plotl > Map > PostMap > NewPostMap > C: \
Surfer \ Dat \ @axmBiomBeputKeao xls (puc. 2).
5. Obyucnennsn 0o’emie & Surfer. J1ns mapa-
XYHKY 00°emy 3a [[MP KOpHUCTYIOTBCS CTaH-
AaptHOW (yHKuiewo nporpamu Surfer — Volume.
Hampuxman, o6’em, OOMEKECHHI MOBEPXHEK,
y SIKIH 3HAUCHHS Z 3aJaH1 Y BUIVISLII QHATI THIHOT
byukuii Z = (x* + y?) 1 maommHow Z = 0. Citky
pospaxoBytore: Grid > Function 1 jarwTs i 1M st
3a 3amMoBuyBaHHsM out.grd > OK (puc. 26).
[Ticns naruckanns knasimi OK BIAKPUBAETBCS
BikHO Grid — Volume (puc. 3) B sSIKOMYy B BEpX-
HeOMYy paaky Upper Surface (Bepxus nosepxiisi)
obpanwii aiin grd.out, B HIKHBOMY psaky Lower
Surface (Huoicna noeepxus) 3a 3aMOBIYBAHHSIM
momuHa Z = 0 (puc. 4) abo JOBaHTAKUTH 3a37a-

Jeriab CTBOPCHY 1 MporpaMa MpOBOAWTH PO3pa-
XYHKH 1 BHJA€ 3BIT PO OOYHCICHHS. 3a BEPXHIO
(Upper Surface) noBepXHIO BHOUPAKOTh BUXIAHY
citky. Hmwxuporo (Lower Surface) moBepxHEO
Oyae mIOMMHA 3 MAKCHMAIBHHM 3HAUCHHSIM
sucotu. [lporpama BHae mNOBIAOMICHHS 1jis
OOYHMCICHUX TPHOMA YHCCIPHUMH METOJAMH:
tparnewii, Cimrcona i 3/8 Cimmcona (tabm. 1).

VY tabmumi | mpeacrasneHi 3HaUCHHS 00 €MIB
3€MIISIHHX POOIT [Tl BEPTHKATIBHOTO TLUIAHYBAHHS
TOPH30HTATBHOI Ta HAXHICHOI JIISTHOK 34 J0TO-
MOTOKO rporpamu Surfer. 3aranpHuii 00 €M IPyHTY
€ CYMOK TMO3WTHBHOTO (HACHI) 1 BIX €MHOTO
(Buivka). YucTrii 00°€M € PI3HULS MIJK BUIMKOO
T HACHTIOM, SIKA MOKA3Y€ TOUHICTh PO3PAXYHKIB.

PisHuug B 06 €Ml 32 TpbOMA PI3HUMH METO-
JaMH TIOKA3ye TOYHICTh HOTO PO3PAXVHKY.
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Puc. 2. [IpoexT peryispHoOi CITKH KBaAPaTiB BEPTHKAIBHOIO TUIAHYBAHHS:
a — rOpM30OHTAIbHA JULIHKA; O — AUTSIHKA 3 HAXHIOM

- Surfer - [Plot1]
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Puc. 3. Posramysanns ¢yHKLii
Volume (06" em)
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1. [Mpuknaa BuzHa4ueHHs 00 €MIB 3eMISIHUX Mac y mporpami Surfer

Topu3oHTAIbHA J1IsHKA

llimmxa 3 NOXH./IOKO IMMOBCPXHCIO

Lower Surface
Level Surface defined by Z =0
Volumes
Z Scale Factor: 1
Total Volumes by:
Trapezoidal Rule: -8.7814210443983
Simpson’s Rule: -8,8356792212153
Simpson’s 3/8 Rule: -8,8325371152976
Cut & Fill Volumes
Positive Volume [Cut]: 819,44797257464
Negative Volume [Fill]: 828,19538348396
Net Volume [Cut-Fill]: -8.7474109093189
Arcas
Planar Arcas
Positive Planar Arca [Cut]: 1277,2458737076
Negative Planar Area [Fill]: 1222,7541262924
Blanked Planar Area: 0
Total Planar Area: 2500
Surface Arcas
Positive Surface Area [Cut]: 1279.1791085406
Negative Surface Area [Fill]: 1224.8624920731

Lower Surface
Level Surface defined by Z = 0
Volumes
Z Scale Factor: |
Total Volumes by:
Trapezoidal Rule: 50,722579354471
Simpson’s Rule: 50,903631349091
Simpson’s 3/8 Rule: 50.897422006906
Cut & Fill Volumes
Positive Volume [Cut]: 1137.4157699233
Negative Volume [Fill]: 1086,5870789475
Net Volume [Cut-Fill]: 50.828690975732
Areas

Planar Areas
Positive Planar Area [Cut]:  3184.0179700975
Negative Planar Area [Fill]: 3215,9820299025
Blanked Planar Area: 0
Total Planar Area: 6400

Surface Areas
Positive Surface Area [Cut]: 3184.721919804
Negative Surface Area [Fill]: 3217.1971296648

Slkmo BCi TpW 3HAYECHHSA 00 €My JOCHTh
ONMU3BKI. TO ICTUHHUN 00 €M OMM3BbKHHA 10 HUX
3HAYUCHB, aJI¢ KOJIU I 3HAUYCHHS BIAPISHAIOTHCS,
TO BHUKOPUCTOBVIOTH HOBMM (aiin 3 O11bLIO0
LIIJIBHICTIO CITKH, NEPLI HIXK MOBTOPUTH PO3pa-
XVHOK 00 emy. Yucruii o6'em moxe OyTH
MPEACTABICHUH K CEPEAHE 3 TPhOX 3HAYCHB.
OCHOBHOIO CKIAJ0BOIO TPOCKTY BEPTHKAIb-
HOTO TJIAHYBAHHS TEPUTOPIH € Kkaprorpama
3eMISIHUX poliT (puc. 3, 6).

6. Pospaxynok mouHoCmi 00MUCICHO20
06’emy. JlocToBIpHICTE 00 €MY 3EMIISIHUX POOIT

1.47 1.27 1.17 1.17

1.32

1.57

XapaKkTEepU3y€e BIJAHOCHA IMOXHOKA V BIACOTKAX,
sika BH3HavaeTbest hopmyiioro [10]:

0,
1 (Vmax - me).loo Yo

m Vep
ae 1/m — BigHocHa moxuoOka: V.1 V,

min
HaUOLIbLIIMH 1| HAHMEHII Ui PO3paxoBaHuii 00™ €M
V., — cepeanpoapuMeTHIHC 3HAUCHHS 00 €MiB
13 TPBOX PE3YJILTATIB.

JlocToBIpHICTE OOYHCICHOTO 00 €MY OLIHIO-
€TBbCS LUISIXOM TIOPIBHSIHHS PE3VIBTATIB TPHOX

PO3paxyHKOBHX METOAIB Ta MO OalaHCy BUIMKHU-

Puc. 5. Beprukanbhe ruiiaHyBaHHs peibedy:
a — KapTorpamMa 3eM/IIHMX POOIT rOPM30HTAIBHOI TUTSIHKH,
0 — TpUBMMIPHA MOBEPXHsI TOPH30OHTATBHOI USTHKU
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Puc. 6. Beprukanbse niaHvBaHHs peiabedy:
a — KapTorpamMa 3eMIISHMX POOIT HAXMICHOI AUTHKH, 0 — TPUBHMIPHA TIOBEPXHsI HAXUICHOT AUTSHKH

Hacumy. [lopiBasiemo fioro 3 06 emom, pospa-
XOBaHHMM 3a BIAIOMHMH B reozesii (opmymamu
(Taba. 2).

BucHoBkH. 3a pe3yabTataMH pPO3pPaxyHKIB
BCTAHOBJICHO, IO BIZHOCHA MOXHMOKA OO4YMCIIE-
HOro 00’ €My TOPH30HTATBHOI AISIHKH 33 TPOMA
metozavu ckiaana 0,06%. bamanc semmsiaux podiT
TaKWi. 34 MPOTPAMHHM KOMILICKCOM Surfer —
1.01%, 3a pospaxyHxoBumu popmymamu — 1,65%,
IO € MCHIIE perameHToBanux 5.0%.

BizHocna mnoxubka obumcieHoro 06 emy
HAXWICHOI AUISHKM 3 TPhOMA METOJAAMH CTAHO-
Buth ,03%. bamanc 3emsiHux poOiT BIATIOBIAHO
ckmagae; nporpama Surfer —4.6%, 3a popmynamvu —
0,8%, mo He nepeBuIIy€e perravMeHToBaHnX 3,0%.

Omxe, 3actocyBanHst mporpamu Surfer 8
Ja€  MOXKIHBICTD OOYMCIIOBATH HE TUIBKH
00 eMH 3eMIISTHUX Mac MDK JBOMA MOBEPXHSIMH
IUIAHYBAHHS, aj¢ 1 IOl LHX ITOBCPXOHb,
JIOCTOBIPHICTD PO3PAXOBAHOTO 00 €My MIATBEp-
JDKY€E BEJIMYHHA BIJHOCHOI TOXHOKH OanaHCy
semmssaux  podit.  [lepeBarm  3acTocyBaHHS
mporpaMu  Surfer8 OOIPYHTOBYIOTBCS 3MCH-
HMICHHSIM OOCSTY Ta TPUBAIOCTI POOIT NPH CKiIa-
JaHHI MPOCKTY BCPTHKAIBHOTO IUIAHYBAHHS Ta
MICPEHECCHHI HOro B HATYpy MiJ 4ac BUKOHAHHS
IH)KCHEPHO-MCTIOPATHBHUX  3aXOMdIB, @ TaKOXK
C€KOHOMIUHICTIO peammi3amii v 38 3Ky 3 MEHIIOK
BIIHOCHOK) Ta AOMYCTHMOK MOXHOKOK po3pa-
XYHKIB T4 BHMIPIOBAHb.

2. BusHaueHHS BIJHOCHOI MOXHOKH 00 €MIB 3eMEIBHUX POOIT

3naueHHs 00’emy | Buimka, M* | Hacun, M ql,dCTHﬁ; CePeﬂHié By jeoria l'IO\:HGKa o
' 06’em. M® | 008’em, M® | oBuncaenoro 06’ emy, %

MeToau 00UMCICHHS TopuzoHTa/IbHA ALISHKA
Tpanewi; E - -8.781 - -
CiMmricona - - -8.835 -8.800 0,06 %
Cimricona 3/8 - - -8.832 - -
Buivxka Ta Hacun 819,448 828,195 -8,747 823.822 1,01 %

3a dpopmymamu:
3a KBaApaTaMH 800 4 813.7 -13.3 - 1.65 %
MeToau OOUMCIICHHS Haxwunena minsgHka
Tpanewii; - - 50,722 - -
Cimncona; - - 50.904 50.840 0.04 %
Cimrnicona 3/8 - - 50.897 - -
Buimka ta Hacun 1137416 | 1086.,587 50,829 1112,002 4.6 %

3a hopmymamu:
3a KBaAparaMu 1088.7 1080.3 8.4 1084.5 0.8 %

2019 = Ne 2 MEJIOPAITIA I BOJAHE 'OCITOJJAPCTBO



256 } MEJIOPAILA 1 BOJTHE T'OCIHOJAPCTBO, X 2 « 2019

BiGaiorpadis

1. Barpaxos FO.I" I'eoae3uueckue cetu crymenus. Mocksa: Heapa. 1987. 255 c.

2. Pypmaxos JLM., I'amiu I'B. Cy4acHwuii cTaH, AMHAMIKa 3MiH Ta MCPCICKTHBH PO3BHTKY T'iApO-
TEXHIYHUX Memopauii v JIHinponerposebkii oonacti / Meniopauis 1 Boase rocrnogapcerso. 2019.
Ne 1. C. 54-60.

3. Tlanaciok H0.A., Jlimuncekuii AT TIpobnemu ynpasiiHHs METIOPOBAHUMH TEPUTOPIsIMH //
I'eozesis, kaprorpadis i acpodorosnimManns. 2011. Ne 75. C. 135-138.

4. Memnioparushi cucremu Ta ciopyau. JIBH B.2.4-1-99. JlepxOya Yipainu. Kuis. 2000. [Beeacni
B airo 3 01.01.2000 p.].

5. Bapan I'L1. Irmxenepna reoaesis: monorpadis. Kuie: [TAT «BITTOJI». 2012, 618 c.

6. BuOpancup K0.M., Tapaciok [.I. MeToauka po3paxyHKy BEPTHKAILHOTO MIaHyBaHHs // BicHUK
HaronansHoro yuisepeutety «JIbBiBchka momitexuika». 2000. Ne 409: Teopist 1 npakrtuka OyaiB-
aunrea. C. 31-34.

7. bapan ILI. Metoau BepTHKANIbLHOTO IMUIAHYBAHHS AN OVAIBEIbHUX MaijaHuukis // BicHuk
rcozesii Ta kaprorpadii. 2011. Ne 6(75). C. 9-15.

8. Cunxun K.10. l'eoundopmaimonnas cucrema Golden Software Surfer 8. Boponesxk. 2008. 66 c.

9. Meanoea M.A.. Yekanues B.A. PeuieHue reoornueckux 3a1a4 ¢ NPUMEHCHHEM TPOrpaMm-
Horo naketa Surfer: mpaktukym. Tomck. 2008. 92 c.

10. 3ycka A.B. Kunemaruueckasi MOACIb OTIOI3HEBBIX CKJIOHOB: MOHOrpadwms / HarmponansHsii
ropusii yHuBepcuTer. Juenponerposck: HI'Y. 2014. 140 c.

References

1. Batrakov. Yu.G. (1987). Geodezicheskie seti sguscheniva [Geodetic networks of condensa-
tion]. Moskva: Nedra. [in Russian].

2. Rudakov, L.M., & Hapich, H.V. (2019). Suchasniy stan, dinamika zmin ta perspektivi rozvitku
gidrotehnichnih melioratsiyv u Dnlpropetrovskiy oblasti [Modemn state, dvnamics of changes and pros-
pects for the development of hydrotechnical reclamations in Dnipropetrovsk region]. Reclamation and
water management, 1, 54-60. [in Ukrainian].

3. Panasyuk, Yu.A., & Lischinsky, A.G. (2011). Problemi upravlinnya meliorovanimi teritoriyami
[Problems of Management of Reclaimed Territories]. Geodesy, Cartography and Acrial Photography.
75, 135-138. [in Ukrainian].

4. Meliorativni sistemi ta sporudi. [Reclamation systems and structures].(2000). DBN B.2.4-1-
99. State building of Ukraine. Kiev. [Entered into force on 01.01.2000]. [in Ukrainian].

5. Baran, PI. (2012). Inzhenerna geodeziya [Engineering geodesy]. Kiev: Vipol. [in Ukrainian].

6. Vibranets, Yu.M., & Tarasyuk, [.G. (2000). Metodika rozrahunku vertikalnogo planuvannya
[Method of calculation of vertical planning]. Bulletin of the National University «Lviv Polytechnic»,
409, 31-34. [in Ukrainian].

7. Baran, PI.(2011). Metodi vertikalnogo planuvannyadlya budivelnih maydanchikiv [ Vertical plan-
ning methods for construction sites|. Bulletin of geodesy and cartography, 6(75), 9-15. [in Ukrainian].

8. Silkin, K.Yu. (2008). Geoinformatsionnaya sistema Golden Software Surfer 8 |Geographic
Information System Golden Software Surfer 8]. Voronezh. [in Russian].

9. lIvanova, LA, & Chekantsev., V.A. (2008). Reshenie geologicheskih zadach s primeneniem
programmnogo paketa Surfer [Solving geological problems using the Surfer software package].
Tomsk. [in Russian].

10. Zuska, A.V. (2014). Kinematicheskaya model opolznevyih sklonov: monografiya |Kinematic
model of landslide slopes: monograph|. Dnepropetrovsk: National Mining University. [in Russian].

I'. B. 'anuy, A. B. 3ycka
Borunciienue 00beMOB 3eMJISIHBIX PA0O0T AJis1 BEPTHKAJIbHOMH MIAHHPOBKH pesibeda
NPH MPOBEJEHHH HHIKEHEPHO-METHOPATHBHBIX MEPONPHUATHIH

Annomanusn. Ilpeocmaenena akmyaivHas npodiemMa MoYHOCHU 6bIYUCTEeHUA 00BeMa 3eMIAHBIX padom,
Umo NO36ONAC VMEHbUUMb CMOUMOCTb Peaiu3ayu RPOeKmd 6epmuKaibHOl MIAGHUPOSKI pelbeda
npU NPOBEOCHUL UHINCEHEPHO-METUOPAMUBHBIX Meponpusmitil. TTpoananuzupoeanst yuebHbie it HaVYHbIE
nyonuKkayu, 20e PaAccMampueaiomcs pasiuuHblie KIaccuyeckue Memoodvl pacuema o0wemos 3emiIsHbIx
mace. Ha ocnosanuu ananumuyeckoeo 0630pa nyoaukayuii cpopmymuposana 3aoava — ROIVYUMb
Haubonee O0CMOBEPHbIE PACHEMHBIE 3HAYEHUA 0TBEMA 3eMISAHBIX PAdOm ¢ NOMOUIBIO ABMOMAMUZUPOBAH-
Ho20 Memoda onpedenetus. Peanuzosan npumep sb14ucIeHus 00beMa 3eMIAHbIX MAce Ol 6ePMUKATLHOT
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MIGHUPOBKI C NPUMEHEHUEM NPOSPAMMHO20 Komniekca Surfers, Komopwiil A614emci Ompaciesvim
CIMAHOAPIMOM ROCMPOCHUA 2PAPUUECKUX UZ0OPadNCEHUTl PYHKYUT O8VX NEPEMEHHBIX U QOHOMN U3 JVHUIUX
nPO2PaMM Ol ROCMPOCHUS MPEXMEPHBIX noGepXHocmell u ux obpabomru. Paccmompena nociedosa-
meibHoCHb pacdemd 00beMos epyHma onsa eepmuk‘a.wmoz‘l HIAAHUPOBKU peﬂbegl)a COPUBOHMATbHO2O U
HAKJTOHHO20 YHUCMKO6 U onpedeﬂeua OMHOCUIMENBbHUA NOZPEULHOCTTB GbIYUCTEHIUI. ﬂocmoeepﬂocmb nojy-
YEHHBIX 3HAYeHUl 00bema oyeHUueaemcAa CpPAGHEHUEM pe3Vibmanoe PAasitidHbIMU PDACHEnHbIMU Memo-
oamu (« Tpaneyuu», « Cumnconay, «Cumncona 3/8» u «keadpamoey) u no GAiaHcy «GbIEMKU-HACHINULY.
YCmaHOB.v"ZCHO, YIMoO ONMHOCUMENbHAA NOCPEULHOCINb 6bIHUCTEHHO20 00beMa 3eMIAHBIX MACC COPU3OHM ATb-
HO20 U HAKIOHHO20 YHacmKkoe Haxooumcs 6 npedenax om 0,03-0,06%, a 6ananc semuanvix pabom — 1,65—
4,6%, umo He npesvliiaem peaiameHmuposartsix cmaroapmanmu 5,0%. pumenerue npoepavmot Surfers
000CHOBBIGACINCA YMEHbUICHUEM 00beMd U NPOOOIAICUMENLHOCII Pabom npi COCMAasieHuu nPoexma
BEPMUKATNLHOT RAAHUPOBKI U NEPEHOCE €20 8 HAMYPY, YKOHOMUYHOCINBIO Peani3ayull 6 Cea3u ¢ MeHbIETl
OMHOCUMENbHOTL 1 QONYCIUMOT ROZPEUHOCILIO PACHEINO8 U UIMEPEHUl.

Kouesote ciosa: eepmuxaivhas niaHUpoBKd, 00bem 3eMIAHbIX pabom, cemra Keaopamoe, yudposas
MOOeb NOBEPXHOCHI.

H.V. Hapich, A.V. Zuska
Calculation of volume of excavation works for vertical planning of relief
at engineering and reclamation activities

Abstract. The article presents the urgent problem of the accuracy of calculating the volume of excavation
works, which allows reducing the cost of the project of vertical planning of the relief of the territory during
the implementation of land reclamation measures. Educational and scientific publications are analyzed,
where classical methods of calculating the volumes of earth masses are considered. The task was formu-
lated to obtain the most reliable calculated values of the volume of excavation using an automated method
of determination based on an analvtical review of publications. An example of calculating the volume
of earth masses for vertical planning was implemented using the Surfer8 software package, which is the
industry standard for constructing graphic images of the functions of two variables and one of the best
programs for constructing three-dimensional surfaces and processing them. Discusses the sequence of
calculating the volume of soil masses for the vertical planning of the relief of the horizontal and inclined
sections and determines the relative error of the calculations. The reliability of the obtained volume values
was estimated by comparing the results with various calculation methods («Trapeziumy, «Simpsony,
«Simpson 3/8», and «Squares ») and the balance of the «embankment ». According to the calculation results,
it was found that the relative error of the calculated volume of the horizontal and inclined sections is in the
range from 0.03-0.06%, and the balance of excavation work is 1.65-4.6%, which does not exceed 5.0%
regulated by standards. The advantages of using the Surfer8 program are justified by the reduction in the
volume and duration of work during the preparation of the vertical planning project and its transfer to
nature, as well as the cost-effectiveness of implementation due to the smaller relative and permissible error
of calculations and measurements.
Key words: vertical planning, volume of excavation works, grid of squares, digital surface model.
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